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Introduction 

l C3D - Cancer Central Clinical Database 
l eCRFs Instructions Manual 
l Support 
l Data Entry 
l Audit-Trail 
l Discrepancy Management 
l Verification 
l Approval 
l Lab Loading 
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What is C3D  

l Clinical Trials Data Management System 
l RDC (Remote Data Capture) Data Entry 
q Accessible anywhere in the world (via a Windows computer 

and Internet Explorer). 
q For studies prior with Clinical Center Number prior to 2012: 

The Java Runtime Environment (JRE) version 1.7.0_45 (or 
later) is required. 

l C3D supports data standardization, reuse, sharing, 
and interoperability through electronic Case Report 
Forms (eCRFs) based on Common Data Elements 
(CDEs) 

l Based on Industry Standard Technologies 
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C3D Organization 
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Designing Protocols in C3D 
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CCR Standard Case Report Forms 

l Library of Standard Forms & Rules is available as a starting 
point to build protocol specific forms & rules 

l Detailed Instructions are available for each Standard Form 
https://ccrod.cancer.gov/confluence/x/9QiJAw  

l Each Instructions includes: 
q General Description 
q eCRF Screenshot 
q Field Specific Description (Mandatory, Derived, etc.) 
q Validation/Derivation Rules 

https://ccrod.cancer.gov/confluence/x/9QiJAw
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eCRF Instructions Manual 



CCR Standard Case Report Forms 

l Screening/Baseline Forms 
q Eligibility, Enrollment, PE, Vitals, Baseline Symptoms, 

Prior Therapies, … 
l Courses/Cycles 
q Course Initiation, Study Medication Administration, PK, 

Course Assessment, PE, … 
l Labs 
q Blood Chemistry, Hematology, … 

l Ongoing 
q AE, Concomitant Measures, Extent of Disease, … 

l Off Tx / Follow-Up / Off Study 
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C3D Protocol Phases 



Role Based Access 
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Access => 
  
Role 

Browse Enter Data Manage 
Discrepancy 

Verify 
eCRF 

Approve 
eCRF 

PI Yes No No No No 

Research 
Nurse Yes Yes Yes Yes No 

Data 
Manager Yes Yes Yes No No 

Monitor Yes No Yes No Yes 

QA Yes No No No No 

Protocol 
Builders Yes Yes Yes No No 



13 

C3D Support 

l CBIIT provides the first line of support for C3D related 
issues 

l Contact 
q Email: ncicbiit@mail.nih.gov 
q Phone: 240-276-5541 (Toll free: 888-478-4423) 
q Additional Information at:  

https://ccrod.cancer.gov/confluence/x/KwBYB   

l Protocol specific issues are escalated to the Protocol 
Builder by CBIIT 

l Changes to Standards are escalated to Controls & 
Configuration Management Group (CCMG) 

mailto:ncicbiit@mail.nih.gov
https://ccrod.cancer.gov/confluence/x/KwBYB
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Username & Password 
l Username is typically your last name and first name initial. 

Ex: smiths 
l Password rules: 

q Start with a letter; 
q Must containing at least one number and one special characters (Ex:! #); 
q Has to be at least 8 characters long; 
q The following special character could cause problems if used: $ % & ‘ ‘’ /. 

l Production Database is called ocprod 
l About C3D Password: 

q Do not share the password with others! 
q Password needs to be changed the first time you login. 
q Passwords expire every 3 months and need to be changed. 
q Account gets locked upon three unsuccessful attempts. Contact C3D Help 

Desk to unlock account and/or get new password. 
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C3D Login Web Pages 

l C3D is Accessible Worldwide 
 

l C3D Production Login Page: 
https://octrials.nci.nih.gov/opa46/rdclaunch.htm 
 

l C3D provides a separate Data Entry 
environment to test protocol design 
q Test Login page: 

https://octrials.nci.nih.gov/opa46/rdclauncht.htm  
 

https://octrials.nci.nih.gov/opa46/rdclaunch.htm
https://octrials.nci.nih.gov/opa46/rdclauncht.htm
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C3D Login Web Page 

Click on Login Button 

For studies with NCI Clinical Center Number prior to 2012 
(ex: 11_C_0001, 10_C_0002), click on the Login button. 
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Login 

Enter User, Password, and Database.  
Then click Connect 
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C3D Activity List 

Select All Data, Active 
Discrepancies, etc. 

Choose Different Studies 

Specify Search Criteria 

Select Data for specific 
Site or Patient 

Study Summary 
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Selecting Activity 
l Quick Links to View 

q All Study Data 
q Discrepant Data 
q Site Specific or Patient Specific Data 

l Change Study button to choose a Different Study 
q Default Study is preserved from prior login 
q Access to study sites and C3D features are controlled by user role 

l Search button used to locate eCRFs based on one or more 
criterion 
 

l Quick Tip:  
q This screen provides a quick review of open discrepancies in your 

study 
q It is strongly recommended to work with one patient at a time 

when performing data entry to avoid entering data in the wrong 
patient position. 
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Selecting Study 

Select Study & Click OK 



Study Access 

l Study/Site access and C3D features 
determined by user role 

l User Roles: 
q Data Managers (Performs Data Entry) 
q Research Nurse (Performs Data Entry and Verifies 

eCRFs) 
q Monitor (Read-only access and Approves eCRFs) 
q Principal Investigator (Read-only access) 
q Reviewer (Read-only access) 
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Search Criteria 

Search Criteria Dialog 
Box 
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Search Criteria 
l Search options: 

q Book - collection of CRFs for a particular version of the protocol (initial 
version or amendments) 

q Site 
q Patients 

o Range of Patients 
q Visits/Pages 

o Phases, Visits, etc. 
q CRF Status 

o Complete, Discrepant, Verified, Approved, etc. 
q CRF Entry Date Window 

o Entry or Modification Date Ranges 
q Data 

o Data entered in an eCRF 
 

l Quick Tip:  
q Protocol Amendments may require different DCI Book. Latest DCI book is 

the default one. Use Search option to select a previous book. 
q Search Criteria Could be saved for future use. 
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RDC Spreadsheet 

Patients down the left 

An Icon indicates the eCRF 
has been created for the 

corresponding patient 

Phases or Visit tabs 
across the top 

Display summary information 
about a Visit, a Patient, a Planned 
eCRF or the selected eCRF.  

Pull Down to view eCRFs 
by Phases or Visits Pull Down to view additional Visits 

Active Filter 

Each column represents 
a planned eCRF 



25 

Navigating RDC Spreadsheet  
l Spreadsheet Layout  
q Patients along Rows 
q Phases or Visits Tabs along Columns; pull down for additional 

visits 
q eCRF within Tabs 
q Cells represents an eCRF for the corresponding Patient-Visit 

l Tabs can be organized by Study, Phase, & Visit 
q When working with Lab eCRFs, choose to work with Visits instead of Phases or 

Study. 
l Information Tabs for Summary, Discrepancies, Verification, 

Audit-trail, etc. at the bottom 
l Navigation Functions via 
q Menu 
q Toolbar 
q Hot Keys 
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eCRF Icons 
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Important eCRF Icons 

l Square icon represents manual entry 
l Round icon represents automated entry (lab load) 
l An eCRF just created, but without data has no lines 

within the icon 
l Partially entered eCRF has lines across half of the 

icon 
l Completed eCRF have lines across the whole icon 
l Blank Square icon indicates eCRF has been marked 

blank 
l Red icon indicates one or more open discrepancies 
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Electronic CRF (eCRF) 

Tabs for eCRF 
Sections Non-enterable field 

Yellow – Univariate 
Discrepancy 

eCRF Scroll Bar 

Ellipsis indicates 
field has a Pick List  
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eCRF Navigation 

l Clicking on eCRF icon open the eCRF 
l eCRF may contain tabs for the different 

sections of the eCRF 
l Grey Fields indicates non-enterable fields 

(Derived, Defaulted, etc.) 
l eCRF Scroll Bars indicate additional information 
l Ellipsis indicates the field has a Pick List. Click 

on the ellipsis or press F9 to display the Pick 
List. 
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Audit Trail 

eCRF specific Audit Trail 
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Audit Trail 

l Audit Trail Tab shows history of all changes 
made to a specific eCRFs 

l Shows current and prior values for each 
changed eCRF field along with the date of 
change and the user who made the change 
 

l Quick Tips: 
q Auditing Begins after Form is marked complete 
q Do not share user ids and passwords! 
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Resizing eCRF Window 

Click Title Bar to enter 
Resize Mode 

Then Click and Drag 
the Title Bar to move 

the window or the 
sides/corners to resize 

Click Done when 
resizing is complete 
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Resizing eCRF Window 

l Click on the eCRF title bar to enter resize 
mode 

l Click and drag title bar to move window 
l Click and drag window edge to expand/ 

reduce window size 
l Click OK when Done 

 
l Quick Tip:   
q Right mouse click on the eCRF title bar to show a pop-up menu 

with options to move/resize the eCRF window. 
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Log Out 

Log out using Exit 



Log Out 

l Exit C3D before closing the Browser 
l Inactivity for more than 30 minutes logs your 

out automatically. Any unsaved work is 
lost! 
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Inserting New Patient 

Icon to Insert New Patients 

Choose Patient Position 
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Inserting New Patient 

l Click Patient Icon or Select Insert -> Patient from the 
menu bar 

l Choose a Patient Position Number from the pick list 
l New Patient Row is Created 

 
l Quick Tips:  
q The total number of Patients available for entry are 

governed by protocol ceiling accrual.  Request additional 
patient numbers if protocol is amended. 

q It is a good practice to use the patient numbers in sync with 
those assigned by Central Registration Office (CRO) 
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Starting New Planned eCRF 

Click on empty Cell to 
insert eCRF and begin 

data entry 



Starting New Planned eCRF 

l Click on an empty cell to insert eCRF and 
begin data entry 

l Resize if necessary   
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Entering Visit Date 

Enter Visit Date and press Tab key 
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Entering New eCRF 
l Click on the empty Cell to insert appropriate eCRF 
l Enter the Visit Date 
q Visit Date is the Lab Sample Collection Date for Lab 

eCRFs! 
q Visit Date is mandatory except for Ongoing Visit eCRFs. 
q Partial dates are not acceptable. 
q Consult eCRFs Instructions Manual for eCRF specific 

guidance: 
o Usually Evaluation Date, Administration Date, Initiation Date, Lab 

Date, Course Start Date, etc. 
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Entering Data in eCRF 

Tabs for eCRF sections 

Indicates Pick List 

Non-enterable field 

Use Tab to move between fields 

Yellow – Univariate 
Discrepancy 

eCRF Scroll Bar 
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Entering Data in eCRF 
l Navigating between Fields 
q Use Tab Key to move to Next Field  
q Use Shift Tab to move to Previous Field 
q Use Mouse Click to navigate to a Specific Field 

l Fields with Ellipsis indicate a Pick List (Use the Pick 
List!) 

l Enter Dates as 
q Complete dates for Current Information (ex: 5/23/2014, 5-

23-2014 or 05232014) 
q MMYYYY for Prior Information is acceptable when 

complete date cannot be obtained (ex: 05-00-2014, 
05/00/2014, 05002014 ) 
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Tabular eCRF 
To Delete Selected Row 

Number of Rows (Repeats) 
allowed for entry and displayed 

are set by Designers.  
Table does not have scroll bar. 
Use Up/Down Arrow Keys to 

Navigate beyond the visible rows. 
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Tabular eCRF 

l Fields shown in a grid layout 
l Scroll up and down the rows of the table using arrow 

keys (No Scroll Bars!!) 
 
l Quick Tips: 
q Use the menu option CRF -> Insert Row to insert a row 

between two rows (below the currently selected row).  
q A row cannot be left blank and must be deleted before 

proceeding to another row.  
o Select the menu option CRF -> Delete Row. 
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Using Pick List 

Click on Field Ellipsis or  
Hit F9 to show Pick List 
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Using Pick List 
l Fields with Ellipsis contain a Pick List 
l Pick List can be accessed by clicking the Ellipsis or pressing the F9 

Key 
l Searching the Pick List: 

q Start typing in some letter and the list is filtered as you type or; 
q Click on the Find box, enter a some letters surrounded by the wildcard % 

character (ex:  %ypo% ) and click on the Find button. Select one of the values. 
q If the Pick List has more than 1,000 items, items beyond 1,000 cannot be 

searched after the Pick List is shown. Close the Pick List and use the 
wildcard find shown above then press the F9 key or click on the ellipsis. This 
way the entire list will be searched and matched items shown. The following Pick 
Lists have more than 1,000 items: 
o CTCAE Term (version 3.0) pick list on the Adverse Events and Baseline Symptoms; 
o Agents in the Concomitant Measures and Medications; 
o Enrollment eCRF Disease Term (only when using comprehensive CTEP list of 

Diseases); 
o Enrollment eCRF Registering Institute; 
o Course Initiation eCRF Treating Institute. 

 
l Quick Tips:  

q If a value is not in the pick list enter it, consult your DM Supervisor. Entering 
a value that is not on the pick list will create a discrepancy. 
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Marking eCRF Blank 

Marking Section Blanks 

Marking entire eCRF Blank 
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Marking eCRF Blank 
l Entire eCRF can be marked Blank 
l Individual Sections of an eCRF can be marked Blank 
l Checking Blank Flag will erase any entered information 

from the eCRF/Section 
l Blank Flag can be unchecked to enter information 

 
l Quick Tip:  
q It is a good practice to mark Sections that will not have data 

entered as Blank. 
q Once all sections of a CRF are ‘addressed’ (by entering data or 

marking it as blank) the overall status of the eCRF becomes 
Entry Complete. 



Entering/Viewing Laboratory Data 
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Add Unplanned 

Show/Hide 
Unplanned 



Entering/Viewing Laboratory Data 

l Laboratory Data eCRFs are designed with 
dedicated Tabs (Hematology, Blood Chemistry, 
Urinalysis, etc.) 

l Additional Lab eCRFs can be viewed by 
clicking Show Unplanned Events 

l Additional Lab eCRFs can be added by: 
q Select the appropriate Lab Visit; 
q Open the patient’s last Lab eCRF on the selected visit; 
q Then select the menu option Insert -> Visit 

o Do not select Insert -> CRF 
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Saving eCRF 

Save Icon 
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Saving eCRF 

l eCRF can be saved using  
q Toolbar Save Icon (yellow floppy disk) 
q F10 Key 
q File -> Save menu option 

 
l Quick Tip:  
q Save Often!! Especially while entering Ongoing 

Information such as AEs and ConMeds. 
q C3D session terminates without warning if there is 

no activity for 30 minutes. 
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Data Entry Change Reason 

Data Changed 
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Data Entry Change Reason 

l Change Reason needs to be specified while 
changing data on completed eCRF 

l Change Reason becomes part of the Audit Trail 
along with date of change and user name 

l Comments can be provided in the change reason to 
further explain 
 

l Quick Tip:  
q Do not use personnel/patient names or identifiers in the 

comments. 
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What is a Discrepancy? 
l A discrepancy is the failure of entered data to pass a 

validation check as applied by C3D. 
l C3D validation checks are defined based on the definition of 

the fields, logical rules, protocol specifications, and sponsor 
requirements. 

l Discrepancies are tools to assist teams in identifying 
potential data inconsistencies and facilitate real-time QA of 
data. 
 

l Quick Tips: 
q Discrepancies do not cover 100% of possible data 

inconsistencies. 
q Clinical judgment may supersede discrepancy logic. 
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C3D Discrepancy Types 

l Univariate 
q Generated during data entry/load when data is in some way 

different from the Question’s definition (e.g. mandatory, length, 
type, range, pick list, etc.) 

l Multivariate 
q Based on a condition on one or more questions as defined in a 

validation rule 
q Generated on-line or when validation rules are run (eCRF must 

be saved as Complete.) 

l Manual 
q Generated by data entry operator seeking clarification on data 

values 
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Some Typical Discrepancies 
Types Example: Resolutions 

Data Type Text entered in numeric or date 
field. 

Review Source Document and 
enter appropriate data. 

Length 
Problems 

Too many characters entered. Use NIH accepted 
Abbreviations. 

Value not on 
the Pick List 

Generic Agent not present in 
Concomitant Agent Pick List 
and user typed in an Agent not 
found on the Pick List. 

Search for alternates. 
Consult Team Lead. 
Request value to be added to 
Pick List. 

Mandatory 
Value 

Required Field left empty. Refer to Source Document. 
Design modification. 

Partial/Invalid 
Dates 

00-10-2010 entered, but field 
requires a full data such as 01-
01-2010 

Refer to Source Documents. 
Check Day Month Year order. 
Check that date is not in the 
future. 
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Outstanding Discrepancies in a Study 
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l Total number of Discrepancies in a study are 
shown in the Activity List 

l Clicking on the ‘Review xx Active 
Discrepancies’ link will present only the 
Discrepant eCRFs 
 

l Quick Tip: 
q Data Managers should manage their 

discrepancies every morning to help ongoing QA 
of data. 

Outstanding Discrepancies in a Study 
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eCRFs Containing Discrepancies 

eCRF Containing 
Unreviewed Discrepancies 

are displayed as Red 



eCRF Containing Discrepancies 

l eCRF containing discrepancies are shown in 
Red 

l It is a good practice to address discrepant 
eCRF on an ongoing basis 
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Discrepancies Tab 

Discrepancies in the selected eCRF 
are summarized in Discrepancies Tab 

First tab enumerates all discrepancies. 
Additional tabs provide individual 

discrepancies details. 
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Discrepancies Tab 

l While viewing an eCRF, clicking on the 
Discrepancies Tab shows the discrepancies 
on that eCRF 

l The first tab gives the summary of all 
discrepancies in that eCRF (open and 
closed) 

l Additional tabs provide individual 
discrepancies details. 
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Discrepancy Details 

Each Discrepancy Detail is in following tabs 

Disc History is available via this button 
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Discrepancy Details 

l Subsequent tabs show details for each 
discrepancy 

l Open Discrepancies are displayed first and 
are followed by Closed Discrepancies 
 

l Quick Tip: 
q Double Clicking on the Discrepancy Text brings up 

a pop-up box with the entire message 
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How are Univariate Disc. Created? 

Univariate Disc Pop-up 

Description 

Operator can cancel to not 
create the discrepancy 

Alternatively, operator can 
accept to create univariate disc 



68 

How are Univariate Disc. Created? 

l Univariate Discrepancies pop-up is presented during data entry 
when the entered value does not match the field definition. 
q Mandatory field left empty 
q Text entered in a Date or Numeric Field 
q Too many characters entered 
q Value is not on the Pick List 
q Partial Date entered when a complete date is required 

l Data Entry operator can: 
q Cancel the pop-up and fix the value 
q Or accept the discrepancy 
 

l Quick Tip: 
q Univariate Discrepancies are reassessed during Batch Validation for Design 

Changes. 
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How is a Univariate Disc. Displayed? 

Data Values with Univariate 
Discrepancies is highlighted 

Data Values with Univariate 
Discrepancies is highlighted 
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How is a Univariate Disc. Displayed? 

l Discrepant data is highlighted in Yellow 
l Discrepancy text provides the details 

 
l Quick Tip: 
q Double Click on the Discrepancy Message Text to 

view the entire message in a window. 



How are Multivariate Disc. Created? 

l Multivariate Discrepancies are created based on validation rules 
programmed in a study 
q Example 1: Create Discrepancy if the entered BSA is not within 10% of the 

calculated BSA 
q Example 2: Create Discrepancy if Date of Histological Confirmation is 

before Date of Diagnosis 
 

l Quick Tip: 
q Rules available as a standard on each eCRF are summarized in the eCRFs 

Instructions Manual. 
q Though several standard rules are implemented for each eCRF as specified 

on the eCRFs Instructions Manual, clinical teams can request them to be 
turned off or modified to comply with the Protocol.  
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Evaluation of Multivariate Rules 
l Validation Rules are evaluated: 
q on-line validation rules are evaluated upon completion of a CRF 

Saved as Complete  
q during an overnight batch validation session for CRFs Saved as 

Complete 
 

l Multivariate Discrepancies are displayed in the same 
manner as Univariate Discrepancies. The Discrepancy 
Details panel indicates the type of Discrepancy. 
 

l Quick Tip: 
q Complex rules run overnight. 
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How is a Multivariate Disc. displayed? 

Discrepancy 
Description 

Discrepancy tab 

Related Data 
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How is a Multivariate Disc. displayed? 

l Discrepancy is based on one or more fields and is 
NOT highlighted in Yellow 

l Discrepancy tab provides the details 
q Discrepancy Text 
q Involved Clinical Data in the evaluation of the Discrepancy 
 

l Quick Tip: 
q The Action pull-down “Go to Data Field” does not work as 

the discrepancy could be based on more than one field. 



How to Address a Discrepancy 

75 

Choose Go to Data Field from Pull Down Menu 

Fix Data as indicated in the Discrepancy Text 
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How to Address a Discrepancy 

l Review Discrepancy Details 
l Whenever possible, use the Action pull down ‘Go to Data 

Field’ to jump to the Discrepant Field 
l Resolve the discrepancy by: 
q Consulting Source Documentation and; 
q Modifying incorrect data and specifying change reason; 
q Requesting eCRF Design and/or Validation Rule Change. 
 

l Quick Tip: 
q System obsoletes univariate discrepancy automatically when 

data is corrected and complies with design/rules. 
q Multivariate Discrepancies are only re-evaluated during overnight 

Batch Validation. 
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Verification & Approval 
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Verification & Approval 

l C3D Verification & Approval functionality 
offer capability to track QA and Monitoring of 
eCRFs. 

l Verification functionality is available for users 
with Research Nurse account role. 

l Approval functionality is available for users 
with Monitor account role. 
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Verification 

Verify Button 

Verification Tab 
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Verification 

l Each eCRF can be verified by clicking on the 
Verify button 

l Verified eCRF Icon has a Checkmark  
l Editing a verified eCRF changes its icon to a 

Re-Verify status  
l Edited eCRF can be re-verified 
l eCRF Verification Change History is 

maintained in the Verification pop-up 
Window 
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Verification 

Verified eCRF 

Re-verification 
Required 
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Verification 

Re-verify Button 
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Approval 

Approval Password 

Approved 

Verified & Approved 

Re-Approval required 

Approval Tab 
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Approval 

l Each eCRF can be approved clicking on the 
Approve button and providing your C3D 
password 

l Approved eCRF Icon has a Signature 
l Editing an approved eCRF changes its icon 

to a Re-Approve status 
l Edited eCRF can be re-approved 
l eCRF Approval Change History is 

maintained in the Approval pop-up Window 
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CRIS to C3D Lab Data Flow 

CRIS CDW C3D 

Lab Mapping 
---------------- 
WBC Count  WBC_SERUM 
Basophils BASO 
Hemoglobin HEMOGLOBIN 
WBC Morphology  ??? 
--- 

LLI 
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What is LLI? 

l LLI is a utility to review and identify specific 
Lab Test Results to be downloaded from the 
CRIS/CDW into C3D 

l URL:  
https://octrials.nci.nih.gov/opa46/labloadinter.htm 

l Username & Password are same as C3D 

https://octrials.nci.nih.gov/opa46/labloadinter.htm
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LLI Search Screen 

Search Criteria 

Selected Panels 

Action Buttons 

Workflow 
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LLI Search Criteria 

 
• Searching 

– Can search by Study, Patient Number, Lab Panel, OC Lab Question, 
Date and/or Time 

• Each search field contains Pick List. 
• Date and Time allows the ‘%’ wild card 
• Date and Time provide the additional option of: 

• “On or Before”, “On or After” and “LIKE” comparisons 
• Partial dates can be entered as %NOV% 
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LLI Search Screen Results 

• Search Results 
– The result set lists Lab Panels that have at least one lab test available 

for loading that meet the criteria entered into the search fields. 
– The sort order can be changed using the column headings. 
– Results can be selected/deselected for processing by using the 

individual select check box or Select Buttons.  
– Entire panels of lab tests can then be moved to the Load Cart or 

Marked for Archive. 
– Clicking  “View All…” button or by double clicking the record presents 

the Work Cart with specific Lab Test Results for that panel. 
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LLI Work Cart 

• Work Cart 
– Shows Entire Panel, including previously loaded and missing Lab Tests 
– The list can be filtered using the “Load Flag” radio buttons. 
– Sort by Lab Test Panel Order (R), Test Name, Results, etc. 
– Results can be selected/deselected for processing by using the 

individual select check box or Select Buttons.  
– Once selected, the lab tests can be moved to the Load Cart or Archived 



Questions? 


	Introduction to C3D
	Introduction
	What is C3D 
	Cancer Central Clinical Database C3D
	C3D Organization
	Designing Protocols in C3D
	CCR Standard Case Report Forms
	eCRF Instructions Manual
	CCR Standard Case Report Forms
	C3D Protocol Phases
	Role Based Access
	C3D Support
	Username & Password
	C3D Login Web Pages
	C3D Login Web Page
	Login
	C3D Activity List
	Selecting Activity
	Selecting Study
	Study Access
	Search Criteria
	Search Criteria
	RDC Spreadsheet
	Navigating RDC Spreadsheet 
	eCRF Icons
	Important eCRF Icons
	Electronic CRF (eCRF)
	eCRF Navigation
	Audit Trail
	Audit Trail
	Resizing eCRF Window
	Resizing eCRF Window
	Log Out
	Log Out
	Inserting New Patient
	Inserting New Patient
	Starting New Planned eCRF
	Starting New Planned eCRF
	Entering Visit Date
	Entering New eCRF
	Entering Data in eCRF
	Entering Data in eCRF
	Tabular eCRF
	Tabular eCRF
	Using Pick List
	Using Pick List
	Marking eCRF Blank
	Marking eCRF Blank
	Entering/Viewing Laboratory Data
	Entering/Viewing Laboratory Data
	Saving eCRF
	Saving eCRF
	Data Entry Change Reason
	Data Entry Change Reason
	What is a Discrepancy?
	C3D Discrepancy Types
	Some Typical Discrepancies
	Slide Number 58
	Slide Number 59
	eCRFs Containing Discrepancies
	eCRF Containing Discrepancies
	Discrepancies Tab
	Discrepancies Tab
	Discrepancy Details
	Discrepancy Details
	How are Univariate Disc. Created?
	How are Univariate Disc. Created?
	How is a Univariate Disc. Displayed?
	How is a Univariate Disc. Displayed?
	How are Multivariate Disc. Created?
	Evaluation of Multivariate Rules
	How is a Multivariate Disc. displayed?
	How is a Multivariate Disc. displayed?
	How to Address a Discrepancy
	How to Address a Discrepancy
	Verification & Approval
	Verification & Approval
	Verification
	Verification
	Verification
	Verification
	Approval
	Approval
	CRIS to C3D Lab Data Flow
	What is LLI?
	LLI Search Screen
	LLI Search Criteria
	LLI Search Screen Results
	LLI Work Cart
	Questions?

